
Stockton Camera Club

Sunset at Mono Lake
Class AA Print of the Month - Ed Richter

Best Friends
Class A Print of the Month - Richard Bullard

View From Dante’s Peak
Class AAA Print of the Month - Suzanne Nichols
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Rose
Richard Bullard

Temple Spires
Dean Taylor

Convicts Dream
Susanne Nichols

Sand River
Em McLaren
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Infinite Reflections
Christine Blue

Gehry Designed Space Station
Dean Taylor

Looking Down
Em McLaren
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Remains of Old Masonic Mine
Ed Richter

Storm Ravaged
Dean Taylor



SCC Officers 2016
President
Heide Stover
Email: h1stover@aol.com

Vice President Programs
Dean Taylor, 986-9848 
Email:  ditaylor49@aol.com

Vice President Competition
Sharon McLemore, 401-0192 
Email:  sfmsap@aol.com

Secretary
Em McLaren, 823-7287
emmclaren@comcast.net

Treasurer
Janelle DeRuosi, 838-1881
Email: jderuosiphotography@gmail.com

Committee Chairs

Hospitality Chairperson
Paul Chapman
Email: uscgchappy@yahoo.com

Print Competition Chairperson 
Trey Steinhart 471-8438
Email: Steinhart4@sbcglobal.net 

Refreshments Chairperson 
Sheldon McCormick 931-0461
Email:smccormick11@Hotmail.com
Shutter Tripper 
Doug Ridgway 617-7050
Email: doug_flyfisher@yahoo.com

Web Master
Janelle DeRuosi, 838-1881
Email: jderuosiphotography@gmail.com
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President’s Message
July 2016

By Heide Stover
Fellow Camera Club Members,

It has been really hot lately. Seems like this would be a great time to get out and do 
some fun water shots. Nice cold water!!!

You can do fast shutter speeds to stop the water and catch the drops or you can do 
slow shutter speeds and get the nice steamy look to the water. You could play around 
with ND filters as Doug talked about at the class he gave. The Japanese Gardens by 
Mickie Grove Zoo has water with big fish in it. The Zoo has water with turtles in it. 
Head down to the Delta for water scenes or out to the coast for a day or two. Lodi 
Lake is another spot where water can be found. If you have children or grandchildren 
or nieces/nephews you can go to Pixie Woods. Need more ideas, just google to find 
some. Water just really sounds good right now! 

Night Scenes, is our special subject for July. Being out in the evening is also a good 
idea, cooler than during the day. With 4th of July coming up there should be plenty 
of chances to get some fireworks shots. Whatever you choose to do have fun with it!!!!

Looking forward to seeing you all at the next meeting!

Happy Shooting.
Heide

219 E Weber Ave (Across From The 
Court House)

Stockton, CA 95202-2706
Phone: 209-464-2299/Fax: 209-464-9229

www.ulmerphoto.com
Email: Ulmerphoto@aol.com

A Big Thank You to Our Sponsors!

mailto:h1stover%40aol.com?subject=
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mailto:%20Sfmsap%40aol.com%20%0D?subject=
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mailto:emmclaren%40comcast.net?subject=
mailto:uscgchappy%40yahoo.com?subject=
mailto:Steinhart4%40sbcglobal.net?subject=
mailto:sfmsap%40aol.com?subject=
smccormick11@Hotmail.com
doug_flyfisher@yahoo.com
http://ulmerphoto.com/
mailto:Ulmerphoto%40aol.com?subject=


Mike Clipka
May 28, 1949 - May 20, 2016

Mike passed away on May 20, 2016. He was a long-time member 
of the Club and was always willing to help others. For many 
years, he was our Education Chairman and wrote his monthly 
column, Clipka’s Corner, for the Shutter Tripper.

He enjoyed photographing Stockton Camera Club events, like 
our workshops and the yearly banquet. He also shared his 
photos with others. He was passionate about his beliefs and 
wanted to see the world become a better place to live. He very 
much enjoyed photographing all subjects but particularly liked 
photographing models. 

Mike was a friendly and outgoing man who was always ready 
to share his expertise at photography with everyone during his 
many years as a member of the Stockton Camera Club.  We 
valued him as a true friend and wish to express our sympathy.  

He had a great spirit and will be greatly missed!
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Topaz Labs

Bryan Peterson School of Photography
 

For a 10% discount go to bpsop.com and apply the code, 
stockton2016, at checkout

breakthrough.photography

For a 15% discount go to 
Topaz Labs and apply the code, 
SCCC15TOPAZ, at checkout
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http://www.topazlabs.com/store
https://www.topazlabs.com/store
http://bpsop.com/
bpsop.com
http://bpsop.com/
http://breakthrough.photography/
https://www.topazlabs.com/store
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CreativeLive empowers you to unleash your potential by bringing 
the world’s greatest experts directly to you, live. Featuring 
workshops in photography, video, design, business, audio, music, 
and software training, CreativeLive unlocks previously closed 
doors by making dynamic education accessible to everyone.

Anyone can watch our live online workshops — for free — and 
interact with instructors in real time. The future of education is 
interactive, free, and live now. Join us.

www.creativelive.com

Trey Ratcliff

RedRiverPaper

https://www.creativelive.com/catalog/all
https://store.stuckincustoms.com/
http://www.redrivercatalog.com/browse/index.htm


Stockton Camera Club Monthly Meeting
June, 2016

Since Heide was not able to be there, Dean opened the meeting. Paul introduced the guests. Dean mentioned that a lot of the 
club members who entered Delicato’s Photo Show did very well this year. Congratulations to all the winners! The show will be 
running until June 25 at the Delicato Winery (off 99 and French Camp Road.) If you can, stop by to visit it.

The North American International photo contest sponsored by the Sierra Club is now open for entries. If you are interested 
please go to the web page: NorthAmericanInternationalExhibition.com to get more information about it. Scroll down to the 
“Contact Us” page for inquiries.

This month there were only Print entries and no Special Subject. Doug is asking that the “12’s” please send him digital copies of 
their prints so he can put them in the Shutter Tripper. Send to: doug_flyfisher@yahoo.com

Susan Bovery also reported that the Ca. State Fair is now having a separate category for photos and all are invited except 
professional photographers. So keep that in mind for next year. 

Dean introduced Susan Bovery from the Woodland Camera Form to judge the prints this month. Her club covers the areas of 
Davis and Yolo County. Their club started in the 1940’s. Susan was trained in Carmel and knew both Ansel Adams and Weston. 
She enjoys photographing everything but in particular likes to photograph abstracts and Black and Whites. She has judged 
many Fairs and Gallery Shows. She had the amazing experience of photographing a live birth recently at a friend’s request.

WINING PHOTO PRINTS FOR JUNE
CLASS A: “Best Friends” by Richard Bullard

CLASS AA: “Sunset at Mono Lake” by Ed Richter

CLASS AAA: “Death Valley - View from Dante’s Peak” by Susanne Nichols

Congratulations to all this months winners!

At the July meeting we go back again to both Prints and Digital Images. The Special Subject for July is “Night Scenes”.

Please let me know if there are any corrections or additions to the minutes. Thanks, em
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A. GENERAL RULES
1. Only paid-up members may enter club competition. 
2. Regular print and digital image competition period: Once 
each month except January. A competition year is February 
through December. Current regular meetings are February, 
March, May, July, September, October and December. The 
number of meetings may change from time to time at the 
discretion of the Board of Directors and approval of the 
general membership as facilities permit. The Annual Awards 
Dinner will be held in January.
3. A total of four (4) images (all prints, all digital or a 
combination of both) may be entered each competition 
month. A total of three (3) images may be entered in the Open 
Division and a total of one (1) in the Special Subject Division. 
The number of entries may change from time to time at the 
discretion of the Board of Directors and the approval of the 
general membership. 
4. Each image will be scored from 6 to 12 points. All prints or 
digital images receiving 11 or 12 points will be classed as an 
honor image. The title of each print or digital image entered 
will be read before being evaluated. The name of the maker 
will be read for 11-point honor winners. Maker’s names will 
be announced for the 12 point images after the Print & Digital 
Image-of-the-Month winners are chosen. 
5. A print or digital image that does not receive an honor score, 
may be re-entered one more time in the same division. 
6. A print or digital image may be entered in all divisions for 
which it qualifies; i.e., an honor image in Open may also be 
entered in the Special Subject Division at another competition. 
A print or digital image that receives an honor score may not 
be re-entered in the same division.
7. Any print or digital image that appears to be ineligible for 
competition or not qualified for a specific division could expect 
to be challenged. The Competition Vice-President shall decide 
whether or not the image is acceptable.
8. The exhibitor must have exposed each negative, slide or 
digital image entered. All images submitted for judging must 
be the work of the photographer/maker including the taking of 
the images and any digital enhancements and/or manipulation 
of the image. This does not apply to the processing of film or 
printing by a commercial processor.
9. The same image should not be entered both as a print and a 
projected digital image in the same competition.
10. In the event of absence or barring unforeseen circumstances, 
a member may submit make-up prints or digital images for 
one competition night per competition year; and whenever 
possible must submit all make-up prints or digital images at 
the meeting immediately following the month a member failed 
or was unable to submit the prints or digital images. Make-ups 
in the Special Subject Division must be the same subject as the 
month missed. Also, in case of absence a member may assign 
the responsibility of submitting his or her prints and/or digital 
images for competition to another member.
11. A club member who serves as judge cannot enter his or 
her own prints or digital images in the same competition. The 
judge’s make-up prints or digital images can then be entered 
in another competition during that competition year. This 
is in addition to the once-a-year make-up provision already 
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2016 Competition Policy

allowed.
12. Prints or digital images may be projected/viewed briefly 
before the judging of each division if the judge indicates he/she 
would like a preview.

B. PRINT ENTRY RULES
1. Each print entered must have a completed label attached 
to the back of the print including; name of maker, title, date 
entered and Division (Open or Special Subject). The writing or 
printing on the form must be legible. Labels must be attached 
on the back of the print in the upper left-hand corner for 
correct viewing of the print.
2. All prints must be matted or mounted with a total size 
(including mat board) of no larger than 18” X 24” and no 
smaller than 8” X 10”. Exception: One side of a Panorama 
Print may be no larger than 36”. Prints that are smaller than 
5” X 7” will not be accepted. The maker’s name must not 
appear on the viewing surface of the image. Framed prints 
shall not be entered.
3. Prints accompanied by entry forms should be submitted no 
later than 15 minutes prior to the start of the regular monthly 
meeting.
4. Prints receiving a score of 12 points, in each class, will be 
regrouped and judged for selection for the Print-of-the-Month 
honors. Print-of-the-Month honors will be given in Class A, 
AA & AAA. 
C. DIGITAL IMAGE ENTRY RULES
1. Digital images must be submitted in a format and by the 
deadline specified by the Competition Vice-President. Digital 
images may be submitted by email, mailed (CD) or delivered 
(CD) to the Competition Vice-President. Definition of Digital 
Image: An image taken with a digital camera, a negative, slide 
or print scanned into the computer and processed digitally.
2. Images must be in a format compatible with the projector. 
The key thing to keep in mind when formatting photos for 
submission is that the projector we use in the competition has 
a (maximum) resolution of 1400 x 1050 pixels. This means that 
any photo that exceeds this size in either dimension, could end-
up being cropped by the projector. In other words: the image 
width cannot be more than 1400 pixels and the image height 
cannot be more than 1050 pixels. If your image is horizontal, 
only change the width to 1400, if your image is vertical, only 
change the height to 1050. Do not change both. Down-sizing 
the image from the “native” resolution coming out of your 
camera also significantly reduces the file size. This helps when 
emailing the files and takes-up less space on our hard-drives.
3. The maker’s name, title of image, date entered and division 
(Open or Special Subject) must be included as the title of the 
image. When you have finished re-sizing your image save your 
image with a new title. For example do a Save as: Smith_
Sunrise Splendor_05-15_O.jpeg. (O-Open or SS-Special 
Subject). Specify whether you’re Beginner, Advanced or Very 
Advanced.
4. Digital Images receiving a score of 12 points, in each class, 
will be regrouped and judged for selection for the Digital 
Image-of-the-Month honors. Digital Image-of-the-Month 
honors will be given in Class A, AA & AAA.
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Stockton Camera Club
Monthly Competition - June 2016

This month’s judge, Dean Taylor, viewed 81 images with an  average of 11.1.  He awarded 13 twelves.  
The following received image of the month honors.

Congratulations to all the winners!!!

Print of the Month Class A – Best Friends – by Richard Bullard
Print of the Month Class AA – Sunset at Mono Lake – by Ed Richter

Print of the Month Class AAA – Death Valley - View from Dantes Peak  – Susanne Nichols

Please check out the website, http://www.stockton-cameraclub.com/home.html
May 2016 - Class A TOTAL OPEN SUBJECT FEB MAR MAY JUNE JULY SEPT OCT NOV DEC

Paul Chapman 160 95 22 42 32 43 43 0 0 0 0 0
Richard Bullard 116 70 0 0 36 34 46 0 0 0 0 0
Diana White 106 64 0 0 33 31 42 0 0 0 0 0
Josh Caine 64 21 0 0 21 0 43 0 0 0 0 0
Lanny Brown 52 52 0 10 22 20 0 0 0 0 0 0
Shari Liwanag 45 45 0 22 0 23 0 0 0 0 0 0
Ron Wetheral 35 35 0 0 0 35 0 0 0 0 0 0

May 2016 - Class AA TOTAL OPEN  SS FEB MAR MAY JUNE JULY SEPT OCT NOV DEC
Ed Richter 175 97 32 39 45 45 46 0 0 0 0 0
Elizabeth Parrish 170 96 30 40 42 44 44 0 0 0 0 0
Kris Borgen 169 95 31 41 44 41 43 0 0 0 0 0
Gary Brown 169 90 34 42 40 42 45 0 0 0 0 0
Sheldon McCormick 162 86 32 40 43 35 44 0 0 0 0 0
Christine Blue 134 67 22 45 0 44 45 0 0 0 0 0
Charlene Martin 30 30 0 30 0 0 0 0 0 0 0 0

March 2016 - Class AAA TOTAL OPEN SUBJECT FEB MAR MAY JUNE JULY SEPT OCT NOV DEC
Dean Taylor 184 71 22 45 48 46 45 0 0 0 0 0
Joanne Sogsti 183 104 35 45 47 47 44 0 0 0 0 0
Susanne Nichols 183 104 33 45 47 45 46 0 0 0 0 0
Sharon McLemore 180 99 36 45 44 46 45 0 0 0 0 0
Em McLaren 178 99 33 44 45 43 46 0 0 0 0 0
Doug Ridgway 175 101 31 41 44 47 43 0 0 0 0 0
Stan Sogsti 175 99 33 44 43 45 43 0 0 0 0 0
Heide Stover 135 104 31 44 44 47 0 0 0 0 0 0
Trey Steinhart 124 101 23 33 46 45 0 0 0 0 0 0
Carol Marshall 83 62 21 41 42 0 0 0 0 0 0 0
Debra Goins 0 0 0 0 0 0 0 0 0 0 0 0

http://www.stockton-cameraclub.com/home.htmlhttp://
http://www.stockton-cameraclub.com/home.htmlhttp://
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2016 Calendar of Events
Every 3rd Thursday

(Except April, June & 
Aug) 6:30 PM

West Lane Bowling Alley
Stockton

Membership Meeting
Contact Heide Stover

h1stover@aol.com

Thursday
July 21

West Lane Bowling Alley
Stockton

July General Meeting
Special Subject - Night Scenes

Thursday
September 15

West Lane Bowling Alley
Stockton

September General Meeting
Special Subject - MACRO (Close-ups) 

Thursday
October 21

West Lane Bowling Alley
Stockton

October General Meeting
Special Subject - Black & White/Monochrome

Thursday
November 16

West Lane Bowling Alley
Stockton

November General Meeting
Special Subject - Prints only with no special subject

Thursday
December 21

West Lane Bowling Alley
Stockton

December General Meeting
Special Subject - Nature (Using PSA rules)

2017 Calendar of Events
January TBA Annual Banquet

Thursday
February 21

West Lane Bowling Alley
Stockton

February General Meeting
Special Subject - Humor

Thursday
March 16

West Lane Bowling Alley
Stockton

March General Meeting
Special Subject - Series of 3 

Thursday
May 21

West Lane Bowling Alley
Stockton

May General Meeting
Special Subject - Movie Titles

Thursday
June 21

West Lane Bowling Alley
Stockton

June General Meeting
Special Subject - Prints only with no special subject



Controlling Lens Flare
Preventing unwanted haze effects and reflected 

light in the field, plus three ways to correct it 
with processing

Text & Photography By Scott Rubey
Labels: How-To

 

As landscape photographers, we’re 
often entirely dependent upon available 
light from the sun. Without a doubt, the 
position of our nearest star can make 
a good image great, or it can make an 
image look flat and mundane. Pointing 
your lens directly toward the sun can 
create terrific lighting effects, but can 
also present a host of problems in the 
form of lens flare. While lens flare can 
be used creatively, it also can produce 
unwanted distractions in landscape 
photographs. When that happens, there 
are a number of techniques we can 
employ, both in the field and later in 
postprocessing, to salvage and elevate 
otherwise unusable images.

What is Lens Flare?
Simply put, lens flare is caused when direct sunlight enters your lens and reflects between the lens elements prior to hitting your 
camera’s sensor. This can have two effects, depending upon where the sun is relative to your lens. 

If the sun is shining on your front element, but is outside your lens’ field of view, the resulting image will suffer a loss of contrast; 
shadows will be washed out, and highlights will appear hazy. The Dehaze slider in the Effects Panel of Adobe Lightroom deals 
with this issue nicely. 

If you’re shooting directly into the sun and the sun is within your lens’ field of view, the resulting effect is an appearance of one 
or more polygonal splotches of various colors.

Reducing Lens Flare at Capture
So, what can we do to tame this phenomenon when capturing a brilliant sunstar or a strongly backlit scene? There are a few 
ways.

• If it’s within your budget, purchase lenses with anti-reflective coatings.

• Avoid using filters. Polarizers lose their effect when shooting straight into the sun anyway, and with Photoshop’s advanced 
blending capabilities, you can leave that split ND in your bag. If you must use a filter, use one coated to reduce reflections.

• Make sure your front element and any filters are free of dust and fingerprints.

• Use a lens hood when the sun is outside your lens’ field of view. You can go a step further by shielding the lens with your hand 
or using a fold-up reflector.

• Use prime lenses, if you have them. Incidence of lens flare is largely dependent upon the number of glass elements inside your 
lens. Since zooms, by design, have more elements than primes, they’re more susceptible to flaring.

• Once each of these considerations has been addressed, use your camera’s Live View function to preview any problem spots 
within your image. When possible, I always try to position residual lens flare in a low-contrast or low-detail area that will be 
easier to fix in postprocessing.
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Figure 1. When lens flare results in just a few small problem spots, Photoshop’s 
Clone Stamp and Healing Brush are great tools to address them.

http://www.outdoorphotographer.com/labels/how-to.html
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Postprocessing Techniques
Despite the myriad precautions you may take during capture, unwanted lens flare can’t always be completely eliminated in the 
field. For these situations, I’ll outline the three postprocessing techniques I’ve found to be most effective in my own workflow.

Cloning and Healing. Depending upon the amount of lens flare you’re encountering and its position within the image, it’s 
sometimes possible to get away with a simple correction using Photoshop’s Clone Stamp or Healing Brush. This technique comes 
in handy when you have only a few small problem spots in areas that lack detail, such as the tree trunk in Figure 1. 

A good rule of thumb for remembering when to use the Clone Stamp versus the Healing Brush is that the former works well 
along distinct edges; the latter works better away from them. This is because the Clone Stamp tool, as its name would imply, 
uses a pixel-for-pixel copy of its sample area, while the Healing Brush blends color information from the sampled area without 
copying exact details, like edges.

The tree trunk in Figure 1 had three distinct problem spots, but took less than 30 seconds to fix using the Clone Stamp and 
Healing Brush. The first two spots were far enough away from the edges of the trunk that a quick fix using the Healing Brush 
worked splendidly. The third spot, situated right along the edge of the trunk, was a good candidate for some careful cloning. 

It can take practice to maintain 
consistent lines when cloning along 
edges such as this one. Always make sure 
you’re working on a layer separate from 
your Background, and set your tool 
parameters to sample layers Current 
& Below. Experiment with each tool, 
sampling areas just above or just below 
the problem spots, and paint over the 
offending lens flare until you’re satisfied 
with the result (Figure 2). Easy! 

Exposure Blending. The Exposure blending method involves equal 
parts fieldwork and postprocessing. This procedure works well when the 
sun is present in your composition (Figure 3).  

Figure 2. With careful use of cloning and healing tools, 
the final image is free from distracting flare effects.

Figure 3. When the sun is present in your frame, 
exposure blending techniques that employ two captures of the scene 

can be used to eliminate lens flare.
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To begin, make sure your camera is locked securely on a sturdy tripod, as 
this procedure won’t work (or at least will be prohibitively difficult) if your 
captures don’t match exactly. Make two exposures: one with the sun present 
in the frame and another in which the sun is blocked by your finger (Figure 4). 

It’s a good idea to manually set your white balance so your colors don’t change 
when the sun is covered up. You also may want to expose a half-stop or so 
brighter for your second frame, as blocking the sun can darken your resulting 
capture a bit. Your camera’s histogram can come in handy here.

Now that you’ve captured your source images, follow these steps:

1. Open your two files in Photoshop. Your first capture, in which the sun is 
visible, will be your Background layer. 

2. Copy your second capture, with the sun hidden, and paste it over your 
Background as a new layer (Photoshop will automatically call this Layer 1). 

3. Add a black layer mask to Layer 1 (Layer > Layer Mask > Hide All). Since 
black equals hide and white equals show in layer masking, your black layer 
mask will hide Layer 1 from view. 

4. Select your brush tool, and set your foreground color to white. Making sure 
your black layer mask is selected in the Layers Panel, begin painting white 
in the areas of the image that exhibit lens flare. Watch as the offending areas 
disappear!

While exposure blending is a powerful method for controlling lens flare, it 
can take some practice. Often, your two source photographs may have slight 
variances in exposure or color due to adding and removing a light source as 
powerful as the sun. 

Experiment with Levels, Color Balance and Exposure adjustment layers and 
masks in order to fine-tune your blended image (Figure 5).

Figure 4. For your second exposure 
when using exposure blending, 
block the sun with your finger.

Figure 5. The final blended image is the result 
of using a layer mask to reveal the second 

exposure (without lens flare) in the areas where 
flare was a problem, while concealing the 

shadow created by your finger.



Frequency Separation - This 
technique has become popular among 
portrait photographers because of 
its ability to edit fine details (high 
frequencies) and color/luminosity 
data (low frequencies) separately 
during retouching. For landscape 
photographers, the method can be used 
to control lens flare in areas of high 
detail, like the hot spot on the rocky 
hillside (Figure 6). With your source 
image open in Photoshop, perform these 
steps:
1.  Copy your Background layer twice. 
Photoshop will automatically call them 
Layer 1 and Layer 1 copy. Layer 1 will 
be your low-frequency layer, and Layer 1 
copy will be your high-frequency layer (I 
like to rename these layers accordingly).
2. Make your high-frequency layer 
invisible by clicking on the Eyeball icon 
to its left in the Layers Panel.
3. With your low-frequency layer 

selected, select Filter > Blur > Gaussian Blur. Move your Radius slider back 
and forth until you find a setting in which your photo is still recognizable, 
but all fine details are gone. For this particular photo, I set my Radius to 
10.
4.  Make your high-frequency layer visible again. With that layer selected, 
go to Image > Apply Image. From there, match all of your settings to those 
in the Apply Image box (Figure 7) and click OK. You’ll be left with a rather 
bizarre-looking layer devoid of much color data.
5.  In your Layers Panel, change the layer blending mode for this layer 
from Normal to Linear Light. Your image now will appear normal again.
6.  Using the Clone Stamp, select your low-frequency layer and sample 

tonal areas near the offending lens flare, painting them into the discolored areas of your image. Because you’re sampling low-
frequency color information rather than fine details, you’ll see that you can correct lens-induced hot spots such as these with 
little to no loss of image quality (Figure 8). 

7.  Frequency separation is an advanced 
technique, and it can take some effort 
to get a perfect result. In this image, I 
had to do some additional cloning in 
order to blend the problem area with the 
surrounding hillside.

Practice Makes Perfect
Learning which of these methods works 
best with a particular image comes 
with experience and practice. Don’t be 
surprised if it takes some false starts and 
experimentation to get it right—I still 
start from square one on most images. 
While there’s no Swiss Army knife that 
will fix each and every occurrence of 
unwanted lens flare, using the techniques 
outlined here will lead to more “keepers” 
and better photos. 

See more of Scott Rubey’s photography 
and learn about his workshops at 
scottrubey.com.
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Figure 6. Frequency separation techniques can be used 
to correct lens flare effects in areas of high detail.

Figure 7. In Photoshop’s Apply Image dialog, use 
these settings for your high-frequency layer. 

Figure 8. The final image, without lens flare hot spots, maintains detail 
by sampling color information from the low-frequency layer.

scottrubey.com


17

Necessary Filters, Even In The Digital Age
Four filters I consider indispensable

By Russ Burden

My photography began with shooting 
slide film. Hence, a large area of my 
backpack housed many filters. The slide 
was the end result. If the in-camera 
capture wasn’t perfect, the image got 
tossed. I had to color correct, evaluate 
the exposure, adjust contrast and 
finalize the crop before I pressed the 
shutter. Since going digital, much of this 
has changed, but there are four filters 
I consider indispensable: the polarizer, 
neutral density, graduated neutral 
density and UV.

Photoshop and other software programs 
enable a photographer to achieve the 
same results of glass or resin filters. A 
new belief has evolved that filters are 
no longer necessary. All the effects can 
be created in post processing. Here’s my 
take:

1. If I can achieve the same effect in the field in a matter of seconds, why spend hours in front of the computer. I already log 
enough time in front of it.

2. Regarding my four indispensable filters, many of the reasons why I use them is the same effect can’t be achieved with 
software.

Polarizer: I love Nik software. One 
of my favorite programs is Color Efex 
Pro. One of the filters found within is 
the polarizer. It works great to enhance 
blues and saturate warm tones. What 
it can’t do is remove glare, eliminate 
reflections, or add neutral density like a 
polarizer does. If glare falls on a shiny 
or colorful subject, color is muted. The 
polarizer eliminates the glare and allows 
color to come through. Reflections are 
often cast upon shiny surfaces such 
as glass, metal and water. A polarizer 
removes the reflection and allows the 
lens to “see through” it and reveal the 
actual subject. A polarizer also adds 
neutral density to provide slower shutter 
speeds.
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Neutral Density: Neutral density filters come in different strengths. 
I own a three- and six-stop. I stack them to obtain 9 stops. They reduce 
the amount of light that strikes the sensor. Most digital cameras have 
a low threshold of ISO 100 and some expand to 50. But that may not 
be enough. If the sun is bright and you need a multi-second exposure, 
the only solution is to add neutral density. In nature photography, the 
cotton candy effect on water requires a slow shutter. The silky look 
can't be created with software.

Graduated Neutral Density: I have used software to produce 
the effect of a graduated ND filter, but this translates to more time in 
front of my computer. Additionally, when I get it “right” in the field, 
I find it more satisfying. Here’s a scenario: someone makes a single 
exposure and reconciles that he/she will resort to “fix” the image in 
post processing. But what if the range between the two contrast areas 
was too severe and he/she didn’t realize this? The result is a photo 
with blown out highlights OR shadow detail with way too much noise. 
The Moral—digital capture shouldn’t encourage sloppy or lazy field 
work.

The UV: Photographically, this filter does nothing. But what it can 
do and has done for me, is saved my front element. If it saves you 
just once, its investment is wise. I buy high-quality filters in that I 
don’t want to put cheap glass in front of my expensive lenses. Even 
with a higher purchase price, if it takes the brunt of a falling lens or a 
scratch, all is good. Try protecting your front element with software!

Visit www.russburdenphotography.com for information about his 
nature photography tours.

www.russburdenphotography.com
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Night Photography
How to Capture the Magic and Mystery 

By Reed Hoffmann 
Photos (12) 

In Rockefeller Center in New York City, 
Reed had no tripod, so he pressed his 
camera down onto the ledge on top of 
the wall behind Prometheus. "I shot 
probably ten or 15 frames to be sure I 
got one with no camera movement; I 
wasn't using the self-timer, just pressing 
the button myself." D7000, AF-S DX 
Zoom-NIKKOR 10-24mm f/3.5-4.5G 
ED, 1.3 seconds, f/18, ISO 200, aperture 
priority, Matrix metering, -1 exposure 
compensation. 

But before how, let's talk about why.

Why take night photos? While they're 
not difficult, they can be a challenge. 
Photography by definition is writing 
with light, and at night...well, you get 
the picture.

When we spoke to pro shooter, Nikon School instructor and night photography enthusiast/advocate Reed Hoffmann, we asked 
him to share some tips for best results, but we first asked him, "Why night photography? What's the big fascination?"

"Partly for the challenge," he says, "but also because not many people do it. Everybody shoots pictures during the day; it gets 
dark and they stop, or they turn on their flash units." And when you're taking pictures that most people don't take, your photos 
might be a bit more interesting, dramatic, even mysterious attention-getting images. "Night photography is not a question of 
getting a picture in low light," Reed adds. "In night photography you're trying to do something special."

Reed's final comment on the "why" of night photography involves the very nature of photography itself. "We teach in our 
[Nikon School] programs that one thing you want to do in your photography is play to the strengths of how cameras see the 
world in ways that are different from how humans see it. Pick up a camera at night and because you can do long exposures, you'll 
see the world in a way you never see it other than in pictures."

And now, how.

First, a Tripod
When there's only a little light, you call on every method possible to make the most of it, and using a tripod is first on the possible 
list. "You're almost always going to need a tripod," Reed says, "especially for creating selective blur with slow shutter speeds—
like moving lights writing their magic lines and shapes." And even with a tripod, to prevent even the slight vibration his finger 
on the shutter release might cause, Reed often uses the camera's self-timer or a cable release to trip the shutter. "And," he adds, 
"when you're using a tripod, make sure the VR function of your lens is turned off."

ISO Boost
No tripod available? Then take advantage of the fact that most Nikon D-SLRs will allow us, in Reed's words, "to shoot at 
ridiculously high ISOs and get very good-looking pictures...even astounding results. Boosting ISO is a valid way to go." (An 
ISO-related tip for scenes involving the night sky: setting shorter exposures at higher ISOs will prevent star trails in the photo.)

Long Exposures
if you're going to pursue night photography, sooner or later you're going to want to do tripod-mounted long exposures, if only to 
see what they'll look like. Slow shutter speeds will let in more light, but they'll do more than that: as the shutter speed slows and 
the exposure lengthens, the magic happens as you capture what the eye can't see.

Autofocus Control
Reed recommends turning off autofocus once focus is achieved. "Once you've got focus, you're probably going to shoot more 
than one picture, and if you leave the AF on for long exposures or time exposures and hit the self-timer, the camera's going to 
search for focus before it shoots. Quite often there's something in the scene that's got some brightness to it, and if you move an 

http://www.nikonusa.com/en/learn-and-explore/article/huayvpnk/night-photography.html#!
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AF sensor to that area, you can focus on it; then just switch off the AF on the lens barrel." If you start your night photography 
before it's truly dark, frame up what you want to capture and use AF to get it sharp; then turn off the AF and wait for the light 
to fade away. "Night photography is a reminder that we can turn off the automatic systems in the camera when we want to or 
need to," Reed says.

Exposure Methods
Reed's standard exposure mode is aperture priority, and he often uses it for night photography as well as daylight shooting. "But 
I use exposure compensation a lot because the meter doesn't know the scene in front of me, or know what I care most about in 
that scene. Matrix metering gets me really close, but exposure compensation lets me dial in the exposure just where I want it." 
He bases his exposure compensation settings on his experience of what a scene calls for, and he can adjust the settings once he's 
checked his images on the LCD. But if something is happening quickly, he'll likely hold the plus/minus exposure comp button 
down and do a three-frame bracket. "Setting exposure in automatic mode is like adding salt and pepper as you're cooking and 
then tasting to see how things are going," he says. "A little exposure comp is going to get it right where you want it."

White Balance
Reed's basic advice is try 'em all and see what suits your style and preference. "Auto white balance will tend toward more 
warmth for yellow and orange lights in a scene. If you've got artificial light, a good starting point is either the incandescent or 
fluorescent setting. If you're not happy with how they look, try the other settings." However, he does caution that while you can 
get creative with white balance by using it to shift colors, "you always want a picture that has a sense of believability to it. You 
don't want people's reaction to be, 'Holy cow, what did he do to that picture?' "

Additional Tools
A look at the LCD tells Reed very quickly whether he's over- or underexposed, but it's the Highlights display option (accessible 
through the camera's Playback menu) that clues him in to what's going on in the highlight areas of his night images. Overexposed 
areas of the photo will flash (many photographers call those flashing highlights the "blinkies"), but the flashing is not necessarily 
an indication that bad things are happening. "You often want small, brightly lit areas of a night shot to be overexposed; expose 
for them and the rest of the scene can go unacceptably dark," Reed says.

Many of the settings you choose will be based on personal preferences discovered through experimentation; at a certain point, 
it's a trial-and-error world out there at night.
 

Reed Hoffmann 
Amusement parks, with all their movement and light, are great for 
after-dark time exposures. "What made this scene [at a park in 
Lucerne, Switzerland] special to me was the reflecting pond and the 
couple between the wheel and its reflection," Reed says. D3S, AF-S 
VR Zoom-NIKKOR 70-200mm f/2.8G IF-ED, 2 seconds, f/11, ISO 
200, aperture priority, Matrix metering, -0.3 exposure compensation. 
Those are the basics that will get you started on night photography. 
And even though we've talked mostly about Nikon D-SLRs, if your 
Nikon digital camera is a COOLPIX or a Nikon 1, just set its controls 
to manual and join the night stalkers. As we've suggested, many of the 
settings you choose will be based on personal preferences discovered 
through experimentation; at a certain point, it's a trial-and-error 
world out there at night.

Reed makes it a point to talk about night photography during Nikon 
School sessions. "Usually I take some time at the end of the second 
day to talk about topics like time lapse, intervalometer, light painting, 
bad-weather shooting and night photography. I tell the class that 
they're 'cool things you can do that most of you probably haven't,' 
and they're sort of a challenge to go further in a specific creative 
direction. And that challenge is a great way to finish the program."

And not a bad way for us to end our story

You can check out Reed's workshop schedule, a selection of his images 
and his blog at www.reedhoffmann.com.

www.reedhoffmann.com.
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How to use slow shutter speed to photograph car light trails. 
The secret to taking fantastic photographs of car light trails is setting your digital camera on shutter priority with a slow 30 
second shutter speed or more. 

Our best photography tips for taking pictures of car light trails at night

• Set your digital SLR camera to shutter priority. This is important for all night photography. Shutter priority allows you to 
set a slow shutter speed so enough light is let in to the sensor. If you don't do this, you will end up with a black image or one 
that only displays circles of light. 

• Use a 30 second shutter speed or more. The slower the speed, the more light you'll see in your photograph.
• Because your taking the photograph with a slow shutter speed, you can now afford to use the lowest ISO setting possible. 

Therefore set your ISO to 100 (if your digital camera goes that low) to ensure the best quality photo with no grainy pixels 
or noise as it's also known. 

• Sit your digital camera on a tripod to miminize the effects of camera shake. The sturdier the tripod the better. If you don't 
have a tripod handy, then sitting the camera on a nearby object would also work. As long as your not hand holding the 
camera.

• Use a camera remote to take the photograph. This stops blurred images that are usually a result of camera shake. Sometimes 
pressing your cameras shutter button can cause a small shift in the camera when you release it. In normal circumstances 
this isn't a problem. However, for night photography on slow shutter speed it can be the difference between a blurred photo 
or a sharp one.

• Wait for a night where there is no wind. This is especially important if your tripod isn't very sturdy. The slightest shake in 
your tripod can cause motion blur. 

• Before you take the photograph, set your lens to automatic focus and focus on a far away object like the sky for example. 
You do this by pressing your shutter button half way down until you see a red dot flashing on the sky or far off object. Then 
turn off your automatic focus so it doesn't change from there on. Your now ready to take a perfectly focussed photograph. I 
have heard many photographers go to the scene they are going to shoot during the day and focus their lens before returning 
at night. However this seems rather tedious to me.

• Take more than one photograph. This is particularly important if you're not intending to return to the same spot again. I 
recently did some night photography taking 3 images of car light trails. Even though I didn't change the camera settings 
between shots, one photograph turned out much sharper than the other two. This is probably due to camera shake caused 
by wind as the weather wasn't the best that particular night. 

 

The image above is an example of night 
photography with car light trails. The 
camera was a Canon 400D (Rebel XTi) 
Digital SLR, set on shutter priority with 
a speed of 30 seconds. Before taking the 
photograph I focused on the night sky 
on the right upper corner. This set the 
aperture to f/22 which resulted in all 
the landscape being in sharp focus. ISO 
speed was kept to 100 to ensure the best 
quality with no grainy pixels. The lens 
was a Canon EF-S 17-85mm f/4-5.6 IS 
USM set at 17mm.

http://www.slrphotographyguide.com/
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